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Preface

This Preface deals with the Manual—how to navigate it, and how to use it. The remainder of the
Manual is devoted to WriteItNow 5—how to navigate it, and how to use it.

Navigating this Manual

This manual uses “hot” links allowing the reader to navigate easily. For example, if the text states that
the Index starts on page ??, then clicking on that page number (??) takes the reader to the Index. (Try
it!) The same is true for Part numbers, Chapter numbers, Section numbers, Appendix letters, Figure
numbers, Table numbers, and the page numbers in the Index. In the Table of Contents, which starts
on page 1, clicking on a Part, Chapter, or Section title (not the page number) immediately opens the
associated part, chapter, or section. Web links, such as http://www.ravensheadservices.com/, open
the associated web page in the default browser. Typically the color or shape of the cursor changes when
over a hot link, which can be seen by hovering the mouse over the previous web link.

Terms and Conventions used in this Manual

Convention

Paragraphs containing important information are identified in
a box similar to this.

Paths

Notations such as C: Users Your Name Documents indicate the path to a folder. In this case it shows
where the folder ‘Documents’ is relative to ‘C:’.

Menu Items

Sequences such as Export Book show the hierarchy of menu items. In this case, the menu item ‘Book’ is
under the menu item ‘Export’. The image Setup indicates the sub-menu item ‘Setup’ is to be selected
in WriteItNow 5. This could also be indicated by Export Book Setup .

Printing Errors and Suggestions

If you find any errors in this manual, or have suggestion to improve it, please send them to http:

//www.ravensheadservices.com/send_email.php by selecting PDF Manual from the Contact Reason

drop-down menu. Thank you.

Rob Walton, UK
David Lovelock, USA

http://www.ravensheadservices.com/
http://www.ravensheadservices.com/send_email.php
http://www.ravensheadservices.com/send_email.php
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CHAPTER 1

Installing and Running WriteItNow 5

The Purpose of This Manual

WriteItNow 5 has extensive built in help and a comprehensive 350 page PDF manual. This manual is
shorter and should be useful to newcomers who want an overview of the program and tips on getting
started.

Overview of WriteItNow 5

WriteItNow 5 is software for writing novels and some non-fiction, such as histories and biographies. It
has sections for the text (front matter, chapters, scenes, and back matter) and sections for background
research (characters, events, locations, props, notes, ideas, references, and submissions).

Obtaining a Copy of WriteItNow 5

An electronic copy of WriteItNow 5 can be downloaded from http://www.ravensheadservices.com/

download.php. The demo version is free and valid indefinitely. It can do most things but it cannot save
or use Add Ons. To convert the demo version to the full version requires unlock codes, which can be
purchased at http://www.ravensheadservices.com/register.php.

The full version of WriteItNow 5 on a CD can be purchased from http://www.ravensheadservices.

com/register.php. It does not require unlock codes.

Installing WriteItNow 5

From Electronic Download

The WriteItNow 5 installation program is called install5XXX.exe (PC) or install5XXX.dmg (Mac),
where ‘XXX’ is the version number, for example, install502c.exe. After downloading, double click
on install5XXX.exe/install5XXX.dmg, and follow the on-screen instructions.

From CD: PC Version

Typically, all that is needed is to put the disk in the CD/DVD drive. This then starts the installer and
by following the on-screen prompts the program can be installed in two or three minutes.

If the installer does not start this could be because the computer’s auto-run feature is disabled. In
this case do the following:

http://www.ravensheadservices.com/download.php
http://www.ravensheadservices.com/download.php
http://www.ravensheadservices.com/register.php
http://www.ravensheadservices.com/register.php
http://www.ravensheadservices.com/register.php
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1. Put the disk in the CD/DVD drive. Wait for a while. If auto-run is enabled on the computer the
installer starts. If this happens go to step 6. If not go to step 2.

2. Open Windows Explorer to view the CD/DVD drive, by holding down the Windows key (this is
between Ctrl and Alt on the bottom left of the keyboard—see Figure 1.1). While the Windows
key is held down press the E key.

Figure 1.1. The Windows key

3. Windows Explorer then shows the computer drives on the computer. One of the drives is the
CD/DVD drive with the WriteItNow 5 CD.

4. Double click on the CD/DVD drive. Windows Explorer shows the programs on the CD.

5. Double click on the file install.exe.

6. When the installer is running follow the on-screen prompts.

From CD: Mac Version

1. Put the disk in the CD or DVD drive. Wait for a while.

2. The CD icon will show on the desktop. Double click on this.

3. Double click on the file install.dmg.

4. This shows an install program. Double click on this to start it.

5. When the installer is running follow the on-screen prompts.

Starting WriteItNow 5

PC

To start WriteItNow 5, click on the icon on the Desktop.
If there is no WriteItNow 5 icon on the Desktop then, in Windows the program is started by

selecting the Start Menu icon, (bottom left of screen), choosing All Programs, and then clicking
on WriteItNow 5. The Windows 8 Start Menu can be accessed by installing the free program “Classic
Shell”, http://www.classicshell.net/.

Mac

To start WriteItNow 5, click on the icon on the desktop or dock.
If there is no WriteItNow 5 icon, run Finder by double clicking on the hard drive icon. Navigate

to the folder where WriteItNow 5 is installed—usually Applications > WriteItNow5. Find the file
writeitnow5.app and double click on it.

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.

http://www.classicshell.net/


8 Installing and Running WriteItNow 5

Unlocking WriteItNow 5

When a user buys WriteItNow 5 on CD or as a download this is recorded and the copy is registered
in the buyer’s name. Buying the software is registration.

To convert the electronic demo version of WriteItNow 5 to the full version requires unlock codes,
which can be purchased at http://www.ravensheadservices.com/register.php.

To unlock WriteItNow 5 go to Menu Panel Settings Unlock , which opens the Unlock dialog in Fig-
ure 1.2.

Figure 1.2. Unlock dialog

The username and codes need to be entered in Figure 1.2. Enter the username in the first line.
John Jones in this example. Enter the first unlock code in the section for Unlock Code 1. The example
uses ‘ABCDEFGH’. Enter the second unlock code in the section for Unlock Code 2. The example uses
‘12345678’.

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.
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CHAPTER 2

Starting a New Project

To start writing a user must create a new project.
A new project is created by clicking the menu item File on the top left-hand side of the WriteItNow 5

screen, and then selecting New Project as shown in Figure 2.1.

Figure 2.1. Create New Project

A dialog is shown asking if the user wants to save the current project. If nothing has been entered
yet select No.

The Create New Project dialog opens. See Figure 2.2.
Enter a name for the project, and the folder to save it in. This example uses the name ‘The Yellow

Cat’ saved in the Writing folder. When finished, press the Create button. This creates and saves a new
project called ‘The Yellow Cat’.

The screen should now look like Figure 2.3. The Overview has the title ‘The Yellow Cat’, and all
other sections are empty. This is a blank project with no characters or chapters.
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Figure 2.2. Create New Project dialog

Figure 2.3. A blank project

Navigating WriteItNow 5—The Screen Layout

The main WriteItNow 5 screen is divided into three main panels., as shown in Figure 2.4.

1. Menu Panel. Across the top the panel, outlined in black, are various menu items, starting with
File . In this manual, components accessed under the Menu Panel are colored black, , and those
that start from the Menu Panel itself, for example File , are shown as Menu Panel File .

2. Tree Panel. On the left-hand side is a panel, outlined in blue, containing a tree-like structure,
starting with Project and ending with Submissions . In this manual, components accessed under the
Tree Panel are colored blue, , and those that start from the Tree Panel itself, for example
Project , are shown as Tree Panel Project .

3. Work Panel. The remaining panel, outlined in red in Figure 2.4 on page 11, has various tabs across
the top—called the Main Tabs—starting with Overview , which is currently selected. The contents

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



Starting a Project 11

Figure 2.4. The three panels

of the Work Panel vary according to the tab selected, but three regions are always present, as
shown in Figure 2.5. To select any of the tabs, either click on that item in the Tree Panel or on
the same item in the Main Tabs. Most tabs have an area for editing called the “Main Text Area”.
Writing Targets are shown at the bottom of the Work Panel.

Figure 2.5. The Work Panel Regions

The Main Tabs

The Main Tabs in the Work Panel shown in Figure 2.5 on page 11 is reproduced in Figure 2.6.

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.
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Figure 2.6. The Main Tabs in the Work Panel

The contents of each of these tabs is now outlined in order.

• The Main Tabs Overview tab stores the book’s title, author, and summary.

• The Main Tabs Front Matter tab stores those sections of the book to appear before the body of the
book, such as a preface or a foreword.

• The Main Tabs Chapters tab contains the bulk of the book, usually divided into chapters and scenes.

• The Main Tabs Back Matter tab stores those sections of the book to appear after the body of the
book, such as an afterword or an epilogue.

• The Main Tabs Characters tab stores character information. This includes name, birth and death
dates, a picture, personality and physical details, and relationships.

• The Main Tabs Events tab is where a writer stores details of when things happen.

• The Main Tabs Locations tab stores details of where things happen.

• The Main Tabs Props tab stores any objects and descriptions that are relevant to the story. Typical
props are vehicles, artifacts, weapons, clues, and so on.

• The Main Tabs Notes tab stores any notes. This might include notes on important parts of the story,
research notes, questions to ask experts, writing advice, and other details.

• The Main Tabs Ideas tab stores any thoughts the writer has for the story.

• The Main Tabs Charts tab displays three charts:
◦ The Relationships Chart, which shows how characters are related to each other.

◦ The Events Chart, which shows a timeline of Events.

◦ The Conflict Chart, which shows the conflict or tension in each scene.

• The Main Tabs References tab holds details of references to publications including authors, publica-
tion dates, publishers, and so on.

• The Main Tabs Submissions tab is where a user can add, delete, and record submission details for a
print book.

The Main Tabs fall into two categories, those that contain the materials to be included in the final
book, called the Book Text, and the remaining tabs, which contain the research materials for the book
(none of which appears directly in the final book), called the Background Details.

WIN5 project consists of two separate components: Book Text and Background Details., shown in
Figure 2.9.

Book Text

The tabs in the Main Tabs that are used to create the Book Text are shown in Figure 2.7.

Figure 2.7. The Book Text

Background Details

The Background Details consist of the Main Tabs after the Book Text has been removed, as shown in
Figure 2.8. The inclusion of Background Details in a project is optional.

Figure 2.8. The Background Details

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



Starting a Project 13

Projects

A WriteItNow 5 project consists of the two separate components: Book Text and Background Details.

Project = Book Text + Background Details,

shown in detail in Figure 2.9 on page 13.
WriteItNow 5 is very flexible and the project could contain just chapters (and possibly scenes) with

no front matter, back matter, or Background Details.

Project

Book Text
Background

Details

Front Matter

Chapters and
Scenes

Back Matter

Overview

Characters

Events

Locations

Props

Notes

Ideas

Charts

References

Submissions

Figure 2.9. Project components

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



CHAPTER 3

Some Editor Commands

WriteItNow 5 contains a fully-fledged editor, with multiple options. In this Chapter, some of the more
important ones are discussed. For a full description see ‘Up and Running with WriteItNow 5 ’.

Whichever of the Main Tabs is selected, they usually have common items, such as Editor Tools , Edit ,
and Format . See Figure 3.1.

Figure 3.1. Editor Tools, Edit, and Format tabs

Section 3.1

The Editor Tools menu

Clicking on the Editor Tools menu brings up Figure 3.2.
In this section, the Spelling Checker is discussed. The remaining are discussed in ‘Up and Running

with WriteItNow 5 ’.
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Figure 3.2. The Editor Tools

Spelling Checker

The program comes with main dictionaries covering US English, UK English and Canadian English.
Each of these has about 125,000 words. To select the main dictionary—the one used by the spelling
checker—go to Menu Panel Settings Tool Settings Set Main Dictionary . The choice of languages is Canadian
(en CA.dict), UK (en GB.dict), and US (en US.dict).

The Spell Checker is activated either by using the keyboard shortcut Ctrl L or by selecting the
menu item Editor Tools Spelling Checker . The first misspelling is highlighted. If there are close alternatives
to this they are shown in the list of Suggested Replacements. See Figure 3.3.

Figure 3.3. The Spell Checker in action

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



16 3.2. The Format menu

If a word has been highlighted it can be changed.

Spell Check Text In Background

Background spell checking is enabled by default. It can be disabled under ‘Editor Settings’ in Figure 3.2
on page 15.

Misspelled words are underlined to highlight them, as can be seen in the example shown on Fig-
ure 3.4.

Figure 3.4. The Background Spell Checker

Misspelled words are highlighted. In Figure 3.4 the word ‘bckground’ has been highlighted with a
wavy underline.

To change a misspelled word right-click on the word.

The Edit tab

Clicking on the Edit tab brings up Figure 3.5.
This menu item exposes the standard list of items used for editing text, such as Copy, Cut, Paste,

Select, etc. The Import Text From File allows the user to insert text at the position of the cursor, from a
DOC, DOCX, RTF, HTML, HTM, or TXT file.

Section 3.2

The Format menu

Clicking on the Edit tab brings up Figure 3.6. This menu item shows options for formatting text, such
as Bold, Italic, left align, right align, etc.

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.
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Figure 3.5. The Edit menu items

Figure 3.6. The Format menu items

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



CHAPTER 4

Adding Chapters and Scenes

Having created a project, described in Section 2 on page 9, a writer usually either writes chapters
and scenes or creates characters. This and the following chapter of the manual are devoted to writing
chapters and scenes for the book, the next deals with creating characters.

In WriteItNow 5, chapters and scenes are the places to write the text that goes into the book. A
book can consist of any number of chapters and each chapter can have any number of scenes. When
writing the book, text can be put in chapters, scenes, or both.

At this stage the user can either enter text directly, or import an existing Microsoft R© Word DOC
or DOCX file. Importing is described in Chapter 12 on page 37.

To enter text directly into Chapters and Scenes go to Chapters either on the Main Tabs or on the
Tree Panel. This opens Figure 4.1.

Figure 4.1. A blank chapter

Figure 4.2 shows a partially completed chapter, with the title ‘A Break’ and some chapter text.
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Figure 4.2. A partially completed chapter

Figure 4.3. Chapters and Scenes

Figure 4.3 shows part of the Tree Panel for a sample
story containing three chapters. Chapter 1—A Break—
has 2 scenes (The Journey Up and Settling In). Chap-
ter 2—Ancient Tales—has 2 scenes (Ancient Treasure
and Searching). Chapter 3—Leaving— has only one scene
(Driven).

To add a blank chapter click on the button shown

in Figure 4.1. To delete a chapter click on the button.
Deleting a chapter also deletes its scenes. It might be wise
to create a snapshot, Ctrl S , before deleting a chapter.

Moving between chapters

To move between chapters, either press the arrow buttons— , , , —in Figure 4.4, or click on
the Go To button. Alternatively, click on the appropriate chapter in the Tree Panel.

Figure 4.4. Moving Between Chapters

Adding a blank scene to an existing chapter

Move to the chapter where the blank scene is to be added. Click on the Scenes tab and then click on

the button in Figure 4.5.

Figure 4.5. Adding, deleting, and moving between scenes

To delete a scene move to that scene and click on the button in Figure 4.5.

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



20 Adding Chapters and Scenes

Moving between scenes

To move between scenes, either press the green arrow buttons— , , , —in Figure 4.5, or click
on the associated Go To button. Alternatively, click on the appropriate scene in the Tree Panel. At any
stage, scenes can added to a chapter, moved to another chapter, or deleted.

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



CHAPTER 5

The Story Board

Figure 5.1. The Story Board

The Story Board is an electronic counterpart of a cork board with index cards—but it is considerably
more powerful. The Story Board can be used to move chapters and scenes around, to add and remove
chapters and scenes, and to edit Chapter and Scene Text, and Chapter and Scene Summary Text.

The Story Board is accessed in a variety of ways.

• Through the keyboard shortcut Ctrl F5 .

• Through the menu item Menu Panel Writing Tools Story Board .

• Through the tab item Main Tabs Chapters Chapter Chapter Tools Story Board .

• Through the tab item Main Tabs Chapters Scenes Scene Tools Story Board .

This brings up the main Story Board, as shown in Figure 5.1.
The Story Board shows the chapters as a column down the left. Any scenes associated with a chapter

are shown to its right. The titles of each chapter and scene are also shown. (The default is to show
only titles, however these cards can also show additional information as detailed on page 22.)
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Moving Chapters and Scenes

Chapters and scenes can be quickly and easily rearranged using the mouse.
Click and drag a scene or chapter card to a new location on the Story board by moving the mouse

to a new position. For example, in Figure 5.1, to move Chapter 1 Scene 2 (‘Scene #2 of 2’) to the end
of Chapter 2 just drag the scene to its new position.

If a chapter is moved all the scenes associated with it are also moved. After rearrangement, scenes
and chapters are renumbered.

The Story Board in Figure 5.2 shows Figure 5.1 with the last scene of Chapter 1 moved to the end
of Chapter 2. Note that the moved scene is now renumbered as ‘Scene #3 of 3’.

Figure 5.2. The Story Board rearranged

Context Menus

There are three different context menus that can be seen by right-clicking on a chapter, a scene, or on
a blank area of the cork board. Right mouse click on a chapter or scene for more options.

Blank Area Context menu

Right-clicking on an unused part of the cork board, opens the context menu with one item, Add New Chapter .
Selecting this creates a new chapter. The placement of that chapter depends on where the cork board
is clicked.

Changing What Is Displayed

The Story Board can show different types of text in the chapters and scenes on the board.
At the top of the Story Board is a check box called ‘Show Large Cards’. See Figure 5.3.

Figure 5.3. Show Large Cards check box

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.
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The default is unchecked. In this case the Story Board looks like Figure 5.4.

Figure 5.4. Show Large Cards unchecked

If the ‘Show Large Cards’ box is checked it looks like Figure 5.5.

Figure 5.5. Show Large Cards Checkbox checked

There are four choices.

1. Show Text. This shows the beginning of the chapter or Scene Text that was written in the Main
Text Area.

2. Show Summary. This shows the Scene Summary Text taken directly from the Scene Summary
described in ‘Up and Running with WriteItNow 5 ’.

3. Show Reading Age. This shows the chapter or scene reading age described in ‘Up and Running
with WriteItNow 5 ’.

4. Show Story Structure. This is described in ‘Up and Running with WriteItNow 5 ’.

Selecting ‘Show Text’ gives Figure 5.6.

Figure 5.6. Show Large Cards checked

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



CHAPTER 6

Creating Characters

All character information is kept in the Main Tabs Characters tab in Figure 2.6 on page 12. This can
include a physical description; gender; personality; pertinent dates; relationships to other characters;
a photograph; the role the character plays in the book (protagonist, antagonist, major character, . . . );
and so on. This material is purely for reference purposes, and is not part of the printed book. Characters
are part of the Background Details described on page 12.

To add a character to the project, select the Main Tabs Characters tab or the Tree Panel Characters in
Figure 2.3 on page 10. This opens a window similar to Figure 6.1.

Figure 6.1. Creating a character

Clicking on the button, creates a blank character, see Figure 6.2. A blank character is added to
the project and this is shown in the Tree Panel with the icon and the name ‘?’ next to it.
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Figure 6.2. A blank character

In the First Name box, enter the name of a character, say ‘Tom’. See Figure 6.3. The Tree Panel is
updated after the name is typed.

Figure 6.3. Entering the character ‘Tom’

Choose the Gender drop down list and set Tom’s gender to Male. The icon for Tom in the Tree
Panel is changed to show this, . See Figure 6.4.

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.
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Figure 6.4. Entering the gender

Repeat these steps to add a few more characters. See Figure 6.5, where two male characters, Tom
and James, and a female character, Lena, have been added. Fill in more details of the characters if
necessary.

Figure 6.5. Adding more characters

To delete a character press the icon.

To switch to a different character either click the corresponding
name in the Tree Panel; or use the Go To button near the top of
the Work Panel in Figure 6.5; or use the , , , icons.

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



CHAPTER 7

Adding Pictures

WriteItNow 5 deals with two types of entities involving pictures, Picture Links and Picture Tabs.

• Picture Links can occur in any Main Text Area. They are only links to images, and are characterized

by the icon. The associated image is not stored as part of the project, nor is it visible within
WriteItNow 5.

• Picture Tabs are present on characters, events, locations, props, notes, and ideas. The selected
picture is visible within WriteItNow 5.

Section 7.1

Picture Links

Links to pictures on the hard drive can be added anywhere in the Main Text Area.

Adding a Picture Link

1. Select an item on the Tree Panel.

2. Place the cursor in the text where the Link is to be inserted.

3. Either use the keyboard shortcut Alt P or
a) Right-click.

b) Click on the menu item Links which brings up the Links Menu, Figure 7.1.

c) Click on Picture Link .

4. The dialog shown in Figure 7.2 opens. Notice the image of the highlighted file is shown, which
helps the selection process.

5. Navigate to the appropriate image and select it.

6. The Picture Link icon, , is inserted in the text.

Section 7.2

Picture Tabs

Writers often use pictures of some of their characters, events, locations, props, or notes to focus their
thoughts. On each of these Background Details there is a Picture tab that lets the writer import an
image. For example, Figure 7.3 shows an open Location tab, with the Picture tab selected. There are
two options. Use Choose to choose a picture and Clear to use no picture.
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Figure 7.1. The Links Menu

Figure 7.2. Picture link

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.
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Figure 7.3. Imported picture

c© 2015, 2016 Ravenshead Services, Ltd. 2016-07-08.



CHAPTER 8

Using the Tree Panel

Figure 8.1 shows a typical blank project. Notice that the items in the Tree Panel are essentially the
same as the tabs in the Main Tabs, except that Overview in the Tree Panel is replaced by the title of
the project, namely The Yellow Cat . To select any item, the user can click either on that item in the Tree
Panel or on the same item in the Main Tabs. For example, selecting the Characters section on the Tree
Panel opens the Characters tab on the Main Tabs.

Figure 8.1. A blank project

After the project is underway, the Tree Panel might look like Figure 8.2, which shows three chapters
(each with scenes) and three characters. The Tree Panel can be used to rapidly select or move an item.
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Figure 8.2. A project

Moving Items in the Tree Panel

1. Left-click on a name in the tree.

2. Drag the name to its new position.

3. If no move is possible a red cross is shown, .

4. When a move is possible the mouse cursor changes to a yellow arrow: an up arrow, , for moving

before an item, and a down arrow, , for moving after an item.

All items in the Tree Panel can be moved in this way, as long
as they are of the same type. For example, Characters cannot be
moved to Scenes, or vice-versa, but a scene can be moved onto any
chapter.
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CHAPTER 9

Saving the Project

To save the project select the Menu Panel File menu and choose Save , or use the keyboard shortcut
Ctrl S . The option to save a project is available only in the unlocked version of WriteItNow 5.

A snapshot represents the project at the time it was saved. WriteItNow 5 saves a snapshot of a
project each time it saves the project. A project can be restored from any snapshot.

WriteItNow 5 allows the writer to set how frequently the project is saved, and to select the maximum
number of snapshots to retain. Setting the Auto Save to save every 30 minutes, and setting the maximum
number of snapshots to keep to 100, is usually sufficient.

Auto Save

Frequency of Auto Save

To set how often the program automatically saves a snapshot, go to Menu Panel Settings Tool Settings

Auto Save , as seen in Figure 9.1 on page 33.
Clicking on Auto Save opens Figure 9.2 on page 33, which allows the user to select ‘Auto Save’ and

to identify how often the snapshot occurs.
Auto Save takes effect after WriteItNow 5 is restarted. It creates a snapshot only if the project has

changed from the previous snapshot. Taking a snapshot is a background operation, and the writer is
unaware of it taking place.

Number of Snapshots

To set the maximum number of snapshots to be kept go to Menu Panel File Restore From Snapshot , as
seen in Figure 9.3 on page 33.

Clicking on Restore From Snapshot opens a figure similar to Figure 9.4, which allows the user to select
the ‘Max. Snapshots to Keep’. If, for example, the maximum number of snapshots is set to 100, then
WriteItNow 5 keeps up to 100 snapshots. It deletes older snapshots.

Restoring a Project from a Snapshot

To restore a snapshot go to Menu Panel File Restore From Snapshot as seen in Figure 9.3 on page 33. This
opens a window similar to Figure 9.4, which shows 5 snapshots. The newest is snapshot 1.
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Figure 9.1. The Auto Save menu item

Figure 9.2. Autosave frequency

Figure 9.3. Restore From Snapshot
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Figure 9.4. Max Snapshots to Keep
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CHAPTER 10

Exporting the Project

Exporting is the process of converting a WriteItNow 5 project, or part of a project, into a file formatted
for use with an external program, such as Microsoft R© Word or Adobe Reader R©. It does not alter the
project.

To create a manuscript, PDF, or eBook the project needs to be exported. To do this select the
Menu Panel Export menu and choose Book , followed by As DOC (MS Word Format) , that is Menu Panel

Export Book As DOC (MS Word Format) . This creates a manuscript in Microsoft R© Word format and
opens the document in that program (if installed on the computer). Creating an eBook, PDF document,
or RTF document follows the same pattern.

The way the book is formatted can be changed by selecting Menu Panel Export Book Setup .
For a more detailed description of exporting see ‘Up and Running with WriteItNow 5 ’.
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Backing Up and Transferring a Project

Backing up a Project

Backing up computer files should be a regular task. All hard drives fail eventually. Backing up to the
same hard drive is asking for trouble. It is much better to back up to an external hard drive or to the
cloud. Better still, back up to both—regularly. See http://www.techsupportalert.com/best-free-

hard-drive-backup-program.htm for a list of free backup programs, with reviews.
The most important thing to back up is the project file! If only one item is backed up, make sure

it is this. If you have pictures make sure you back up the pictures folder. The project file is the one
ending in *.wnwx, for example, My Book.wnwx. The pictures folder is a sub folder which is created in
the folder where the project is saved.

For a more detailed description of backing up see ‘Up and Running with WriteItNow 5 ’.

Transferring a Project from one Computer to Another

This can be done in two different ways.

• Using a thumb drive.

• Using one of the many free1 cloud services available, such as “Box” (https://www.box.com/home/),
“Dropbox” (https://www.dropbox.com/), “OneDrive” (https://onedrive.live.com/), and so
on. (There can be issues with access immediately after exporting or saving to a cloud-linked folder
for projects.)

Whichever method is chosen, the process is essentially the same.

• Use the backup procedure described on page 36 to copy the data from the source computer to the
thumb drive or cloud.

• Install WriteItNow 5 on the destination computer, if it is not already installed. Unlock it with your
unlock codes.2

• Copy the data from the thumb drive or cloud to the relevant folders in the destination computer.

1 Each of these web file storage services have a basic amount of free disk space.
2 “You can install and use WIN5 on any computers which you own or use regularly as long as the installation is for your

own use.”

http://www.techsupportalert.com/best-free-hard-drive-backup-program.htm
http://www.techsupportalert.com/best-free-hard-drive-backup-program.htm
https://www.box.com/home/
https://www.dropbox.com/
https://onedrive.live.com/


CHAPTER 12

Importing Existing Text

Importing is a way to get text from other sources into WriteItNow 5, without retyping. For example, if
someone has started a book in Microsoft R© Word they can import this into WriteItNow 5, and continue
writing it.

Supported formats are DOC (Microsoft R© Word), DOCX (Microsoft R© Word), RTF (most word
processors), HTM (web page), HTML (web page), and plain text TXT (most text editors). There is
no provision for importing PDF documents. This chapter is devoted to importing a DOC file. The
remaining file types are imported in a similar way.

Before importing it would be wise to save the current project in
case the import produces an unexpected result.

There are two ways to import text from other sources: Automatic Importing—where no text is
selected by the user—and Interactive Importing—where the text to be imported is selected by the
user. Each of these options is accessed from the Menu Panel via the Import menu item, see Figure 12.1.

Figure 12.1. Import Menu

Whichever method is selected, the file to be imported should be prepared ahead of time to identify
different sections—Chapters, Scenes, Front Matter, Back Matter, Characters, Events, Locations, Props,
Notes, and Ideas. An unprepared file can be imported directly, but it will come in as one long chapter.

The simplest method is to identify each section with its category name (Chapter, Scene, . . . ) and
then use Automatic Importing. For example, after automatic importing, the text

CHAPTER I am Born

Whether I shall turn out to be the hero of my own life, or whether that station

will be held by anybody else, these pages must show.
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SCENE The Beginning

To begin my life with the beginning of my life, I record that I was born (as I

have been informed and believe) on a Friday, at twelve o'clock at night.

CHARACTER David Copperfiled

David was born in Blunderstone, Suffolk, near Great Yarmouth, Norfolk, England,

in 1820, six months after the death of his father.

LOCATION Blunderstone, Suffolk

Blundeston is a village and civil parish in the Waveney district of the English

county of Suffolk.

EVENT Birth of David Copperfield

April 28, 1820

PROP Book

"David Copperfield" by Charles Dickens

NOTE Read David Copperfield

Take out of library

IDEA Another book

Oliver Twist is a good title.

creates a chapter titled “I am Born”, a scene titled “The Beginning”, and so on. See Figure 12.2.

Figure 12.2. A project using Automatic Import

If, for example, an existing scene has no title, then the word “Scene” on its own line will create a
scene titled “Scene”.
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CHAPTER 13

Writing Targets

Writing targets can be set to show how many words have been written in a session and how long has
been spent writing in the session. They are calculated automatically from when the program is opened.
Targets can be shown or hidden.

Setting Writing Targets

To set writing targets go to Menu Panel Writing Tools Writing Targets or use the keyboard shortcut
Ctrl F7 . This opens a window similar to Figure 13.1.

Figure 13.1. Setting Writing Targets

1 Words Written. This shows the number of words written since the session start.

2 Show Words Written. If this is checked then the words written target is shown below the Work
Panel.

3 Reset Words Written. Clicking the Reset Words Written button sets the number of words written back
to zero.

4 Targets Word Count. The total number of words the user wants to write as a target for this session.

5 Time Writing. Shows the amount of time that has been spent writing since the session start.

6 Show Time Writing. If this is checked then the writing time target is shown below the Work Panel.

7 Reset Time Writing. Clicking the Reset Time Writing button sets writing time back to zero.
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8 Writing Time Target. This is the target time for writing hours and minutes.

9 Maximum Pause. This sets the maximum pause in seconds before the writing timer stops. For
example, if this is set to 10 seconds then any pause greater than 10 seconds pauses the timer. The
timer restarts when the next word is written. If the maximum pause is set to 600 seconds then the
writer could stop writing for ten minutes before the timer pauses. A reasonable value is from 10
to 60 seconds. By default the maximum pause is set to zero. When set to this value the elapsed
time increases constantly.

Words Written

The number of words written is shown below the Work Panel. Figure 13.2 is an example. It shows the
number words written, ‘49’, the target set, ‘400’ words, and a progress bar, ‘12%’.

Figure 13.2. Words Written

The words target shows words written. It does not include any
words that have been cut and pasted into the project. Deleting text
does not reduce the number of words written.

When the target set is exceeded the progress bar color changes and the percentage value increases.
For example, suppose a words target of 500 words is set, then after writing 490 words the words target
looks like Figure 13.3.

Figure 13.3. Number of words below Words Target

After writing 520 words Figure 13.3 looks like Figure 13.4.

Figure 13.4. Number of words exceeds Words Target

When exiting the program the writing target is updated using the number of words already written.
For example, if the writing target is set at 500 words and 300 words are written, then on exit the target
is changed to 500 − 300, or 200 words.

If a user wants the writing target to always start at a particular
value for each session then select Menu Panel Settings Tool Settings and
ensure that “Update Word Target on Program Exit” is not selected.

Time Writing

The time spent writing is show below the Work Panel. Figure 13.5 is an example. It shows the time
spent writing, ‘00:02:00’ (two minutes), the target time set, ‘00:30:00’ (thirty minutes), and a progress
bar, ‘6%’.
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Figure 13.5. Time Writing

If, in Figure 13.1, a maximum pause greater than zero is selected, then the writing time only increases
while actually writing. Stopping writing for longer than the maximum pause time causes the elapsed
time to stop. It resumes when the next letter is entered.

Simply sitting staring at the screen and not writing does not
count towards the target. Pausing for longer than the maximum
pause time allotted pauses the time target.

When the target set is exceeded the progress bar color changes and the percentage value increases.
For example, suppose a time target of 6 minutes is set, then after 5 minutes and 56 seconds the times
target looks like Figure 13.6.

Figure 13.6. Time below Time Target

After writing for 8 minutes and 20 seconds Figure 13.6 looks like Figure 13.7.

Figure 13.7. Time exceeds Time Target
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CHAPTER 14

Getting More Help

There are three complimentary ways of getting help in WriteItNow 5.

1. Help built into WriteItNow 5.

2. Web tutorials.

3. The downloadable manual ‘Up and Running with WriteItNow 5 ’.

Help built into WriteItNow 5

WriteItNow 5 has extensive help, which can be displayed either within WriteItNow 5 or in the default
web-browser. The choice is made from Menu Panel Settings Tool Settings , by checking or unchecking
Use Web Browser to Show Help .

Help is obtained in three ways.

• By using Menu Panel Help from the Menu Panel. See Figure 14.1. The Search option searches the
Help for any text, while Index displays an alphabetical index of Help items. The remaining menu
items are topic-specific or offer general help to the user.

• By pressing the F1 key.

• By clicking the question mark icon , when available.

Printing Help

In the left-hand tree view of the Help, click on the sections to be printed. To select multiple sections,
hold down the Ctrl key.

Web Tutorials

If the computer is connected to the Internet, then by selecting Menu Panel Help Web Tutorials (see
Figure 14.1 on page 43), various instructional videos on the use of WriteItNow 5 can be viewed.

The Manual ‘Up and Running with WriteItNow 5 ’

The manual ‘Up and Running with WriteItNow 5 ’ can be downloaded freely from http://www.

ravensheadservices.com/UpAndRunningWIN5.pdf. It is over 350 pages long and covers all the features
of WriteItNow 5 in addition to being packed with tips and advice.

http://www.ravensheadservices.com/UpAndRunningWIN5.pdf
http://www.ravensheadservices.com/UpAndRunningWIN5.pdf
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Figure 14.1. The Help menu items

Support for WriteItNow 5

To contact the authors of WriteItNow 5 with any questions go to http://www.ravensheadservices.

com/send_email.php.
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